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SAFETY INSTRUCTIONS 
For safe use of your MBH2BT01, always follow the instructions below. 
This guide uses graphical symbols to highlight instructions that you must follow to avoid personal injury or damage to 
property when using the MBH2BT01. Before reading this guide, read the following explanations carefully to fully 
understand the meanings of these symbols. 

 
ELECTRICAL PRECAUTIONS 

·  This device could malfunction in the event of a voltage sag or momentary drop in voltage because of electrical 
disturbance. To protect your computer against voltage sag, use of an uninterruptible power supply (UPS) is 
recommended. 

·  The frequency band used for this device is the same as for some types of industrial, scientific, and medical 
equipment, including microwave ovens, as well as on-premises radio stations, (e.g., radio stations installed in 
production lines), and other application-specific low-output radio stations. Before using this device, make sure there 
is no on-premises radio station near the device.  

·  In the event this device causes radio frequency interference to an on-premises radio station for identification of 
mobile units, immediately change the frequency used or break off connection, and consult FM Information Service 
about preventive measures against radio frequency interference (for example, installation of partitions). 

 
CAUTIONS 

·  Remove the MBH2BT01 from your computer or turn off your computer in a hospital or near a medical electronic 
system. Do not bring your computer with the MBH2BT01 connected in an operating room, otherwise radio waves 
transmitted by the MBH2BT01 could affect medial electric systems. 

·  Keep your computer at least 8.5 inches (22 cm) away from a pacemaker, otherwise radio waves could prevent it from 
functioning properly. 

·  Remove the MBH2BT01 from your computer or turn off your computer on an airplane or when driving. 
·  Remove the MBH2BT01 from your computer where it can be exposed to flammable gas, otherwise it could cause an 

explosion or fire.  
·  Do not use the MBH2BT01 near an automatic door or fire alarm, otherwise radio waves transmitted by the 

MBH2BT01 could affect its automatic control unit. 
·  Never disassemble, repair, or modify the MBH2BT01. Touching internal components could cause you to get an 

electric shock. 
·  Do not place vessels containing liquid near your computer. Liquid could cause an electric shock if it gets in the 

computer. 
·  When inserting the MBH2BT01 in a card slot or ejecting the card from it, don't put your finger into the slot. 
·  The MBH2BT01 may heat up after being used for a long period. Do not remove it from your computer immediately 

after use. 
·  Do not bring magnetic cards, including floppy disks and credit cards, close to the MBH2BT01, otherwise data 

recorded on them could be lost. 
·  Do not use or store the MBH2BT01 where it will be exposed to shock or vibration. 
·  Do not place the MBH2BT01 where it will be exposed to extreme heat or cold, or where the temperature can greatly 

vary. 
 
Registered Trademark(s)®, Trademark(s)™ and Service Mark(s)SM 

BLUETOOTH is a trademark owned by Bluetooth SIG, Inc., U.S.A. and licensed to Fujitsu. 
Microsoft, Windows, Outlook, ActiveSync, and the Windows CE logo (graphic only) are either registered trademarks 
or trademarks of Microsoft Corporation in the United States and/or other countries. 
BTW-CE is licensed from WIDCOMM, Inc. to Fujitsu Media Devices Limited. 
Other brand and product names may be registered trademarks, service marks, or trademarks of their respective holders. 

 
We cannot guarantee the accuracy of the contents of this document. We disclaim liability for errors, omissions or 
future changes. 
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FCC Part 15 Subpart B Class B 

NOTICE 
 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. 
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following measures:  
 
 -Reorient or relocate the receiving antenna 
 
 -Increase the separation between the equipment and receiver. 
 
 -Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
 
 -Consult the dealer or an experienced radio/TV technician for help. 
 
 

FCC WARNING 
Changes or modifications not expressly approved by the party responsible for compliance could void the user's 
authority to operate the equipment. 
 
 
This transmitter must not be co-located or operating in conjunction with any other transmitter or antenna. 
 
 
This device complies with part 15 of the FCC Rules. 
Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, 
including interference that may cause undesired operation.
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1 Introduction To Bluetooth Software (BTW-CE) for MBH2BT01 
BTW-CE is the solution for the seamless integration of Bluetooth technology into devices that use the 
PocketPC operating system and MBH2BT01. It provides PocketPCs with the means to: 
· Locate other Bluetooth devices in the immediate vicinity (inquiry) 
· Discover the services that those devices offer (discovery) 
· Connect to, use, and disconnect from those services 
· Enable/disable individual services 
· Security features, on a service-by-service basis, including: 
   Authentication 
   Authorization 
   Encryption. 
This User’s Guide is divided into four major sections: 
· Introduction 
· Configuring BTW-CE—see the sections on the Bluetooth Control Panel 
· Using BTW-CE—see the sections on the Bluetooth Manager 
· Using Remote Device Services—an overview of how to use services provided by remote Bluetooth 
 devices. 

 
1.1 BLUETOOTH ICON  

The Bluetooth icon in the lower-right corner of the Today screen provides quick access to the Bluetooth 
Control Panel. 
It also provides visual feedback about whether Bluetooth is “on” or “off”: 
· When BTW-CE is active (on) the Bluetooth icon is blue. 
· If BTW-CE is disabled (off) the icon appears grayed with a red X in the lower right corner. 
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1.2 INSTALLATION 
 

1.2.1 Requirements 
1. A desktop computer with: 
  Microsoft Windows 98SE, Me, 2000 or XP operating system 
  CD-ROM drive 
  Microsoft ActiveSync, version 3.0 or greater. 
2. A handheld computer that is capable of accepting MBH2BT01. 

 
1.2.2 Installation Process 
NOTE: Your PocketPC must be connected to your desktop (via ActiveSync) during the installation. This is 

required for the installation process to properly update the PocketPC. Should you re-install 
BTW-CE, you must execute the full installation procedure (i.e. run Setup.exe) instead of 
re-installing BTW-CE from ActiveSync (via the Add/Remove Programs option). 

1. On the PocketPC: 
Insert the MBH2BT01 into the handheld device. 
Connect the PocketPC to the desktop computer. Microsoft ActiveSync will automatically establish a 
connection. 

2. On the desktop computer: 
a) Insert the BTW-CE compact disc into the CD-ROM drive. 
b) When the Welcome screen appears, Click Next to continue. 
c) Click Yes to accept the License Agreement and install the software on the desktop computer. 

3. On the handheld device: 
  Tap Yes to accept the default directory and install the software. 

4. On the desktop computer: 
  Click OK to close the Download Complete dialog box, and then click Finish. 

5. On the handheld device: 
a) A Welcome screen will be shown with basic instructions to use BTW-CE . 
b) Check off Add a shortcut in the Start menu in order to have access to the Bluetooth Manager 
from the Start menu (otherwise, the Bluetooth Manager will be accessible from Start > 
Programs). 
c) Perform a “soft” reset of the handheld computer. Refer to your device’s documentation for the 
exact procedure. 

NOTE: A soft reset leaves installed applications and stored data intact, and simply restarts the device. A 
hard reset deletes ALL downloaded applications on the handheld. See the handheld computer’s 
documentation for additional information.  
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2 Bluetooth Control Panel: Configuring BTW-CE 
BTW-CE provides a Control Panel to adjust Bluetooth settings. 
To access the Control Panel, in the lower-right corner of the Today screen, tap the Bluetooth icon. 
BTW-CE can have multiple saved configurations. Individual configuration sets are saved in profiles, 
which can be quickly loaded to meet the appropriate situation. See Section 2.1.1 for more information 
about profiles. 
The Control Panel has seven tabs. All tabs are not visible on the screen at the same time; use the arrows 
to the right of the tab names to scroll back-and-forth and expose the different tabs. 

 

The Control Panel’s tabs are: 
· General 
  User profile selection 
  Bluetooth status (ON/OFF) indicator 
  Hardware power control (ON/OFF) 
  Shortcut to the Bluetooth Manager. 
· Accessibility 
  Set the device name 
  The device’s Bluetooth Device Address (BDA) 
  Determine which remote devices are allowed to connect 
  Determine whether remote devices can “see” this PocketPC. 
· Service tabs—BTW-CE can provide four services. They are: 

File Transfer—set the highest-level directory on this PocketPC that remote devices will be able to 
access. 

  Information Exchange—Set the default business card (Pocket Outlook contact entry) 
  Serial Port—Bluetooth serial port information 
  Dial-up Networking—configure the COM port, baud rate and flow control. 
· About—there are no configurable options on this tab. 
  Software version information 
  Copyright information 
Each of these tabs is explained in detail in the remainder of this section. 
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Figure: Configuration overview 
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2.1 GENERAL TAB 
There are three options on this screen:  
· Current Profile: to change the active profile, tap the down-arrow in the “Current profile:” field and 
select the new profile from the drop-down list. The current profile will be saved, and the settings from the 
selected profile will be loaded. To add, delete, or rename a profile, tap (see Section 2.1.1). 
· Bluetooth Status: 
  MBH2BT01 status. 
· Bluetooth Manager: 
  Tapping on this shortcut starts the Bluetooth Manager. 
When Bluetooth is OFF, no connections, incoming or outgoing, are possible. 
When Bluetooth is ON, Bluetooth is always “up” and battery drain is significantly greater than when 
Bluetooth is disabled. To conserve battery power, do not enable Bluetooth when it is not being used. 

 

2.1.1 Profiles 
Profiles are accessed and managed from the Control Panel, General Tab. They allow: 
· Different users to quickly re-configure a PocketPC to their personal preferences. For example, if Joe 
and Mary both use the same PocketPC, but each uses it for a different purpose, selecting a pre-configured 
profile will alter the settings to those of the appropriate user. 
· A single user to quickly re-configure a PocketPC for a different environment. If Joe uses his device 
primarily at the office, but also uses it when traveling, he can easily switch to a pre-configured profile 
that has more secure settings for hotel, airport and similar “public” environments. 
All Bluetooth settings are saved in the active profile. A profile named “Office,” for example, may include 
Bluetooth Authentication and Encryption settings, and connection icons to specific services on 
work-related Bluetooth devices. A profile named “Private” on the same device may only allow the 
owner’s laptop computer to connect to the PocketPC. When the “Private” profile is selected, only the 
Bluetooth settings related to that profile are active, the “Office” profile settings have no affect. 
When the PocketPC is turned off, BTW-CE saves the last-used profile and reloads that profile the next 
time the device is turned on. 
The Profile options (available from the Control Panel, General Tab) are: 
· A list of existing profiles—when BTW-CE is started for the first time the only profile listed will be 
“Default.” To enable a profile, tap it. 
· accesses a screen from which you can: 
  Add a profile 
  Rename a profile 
  Delete a profile. 
2.1.1.1 Create A New Profile 

1. From the Today screen, tap the Bluetooth icon. 
2. From the General tab, tap. 
3. From the Add/Delete Profiles screen: 

a) Tap the New button 
b) Enter a descriptive name for the new profile, for example, “Office.” 
c) Select an existing profile on which to base the new profile. 

4. Tap the OK button. 
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The new profile does NOT automatically become the active profile; to activate the new profile, select 
it from the “Current Profile” field on the General Tab. 

2.1.1.2 Rename or Delete a Profile 
1. From the Today screen, tap the Bluetooth icon. 
2. From the Bluetooth Control Panel, General tab, tap. 
3. From the Add/Delete Profiles screen: 

a) Tap a profile name, then the Rename button and enter the new name. 
or 

b) Tap a profile name, then the Delete button. 
2.1.1.3 Save Configuration Settings In A Profile 

When you make changes to the PocketPC’s configuration, those changes are automatically saved when 
you select a different profile, turn Bluetooth off, or shut down the PocketPC. 
To save a specific configuration: 
1. Select (or create and then select, see Section 2.1.1.1) the desired profile (for example “Travel”) from 
the Current Profile field on the General Tab. 
2. Setup the PocketPC (see Section 2) so that it behaves in the desired manner. 
3. Tap OK 
4. Close the Control Panel; the changes are saved automatically. 
To use the Travel profile and its associated configuration in the future, from the Control Panel, General 
Tab, select “Travel” from Current Profile drop-down list. 
To avoid saving unwanted changes to a regularly used profile, create a new profile that is based on the 
profile currently in use (see Section 2.1.1.1), select the new profile, and then make the changes while 
the new profile is active. 

 
2.2 ACCESSIBILITY TAB 

All information on this tab is saved with the active profile, including the device name. 
The options on the Accessibility tab are: 
· Device Identification: 
  Name—the name of this device, as displayed to remote devices when the associated profile is active. 
To change the device name associated with this profile, highlight the name and enter the new name. 
  Address—the Bluetooth Device Address (BDA) of this device. This information is permanently 
associated with the Bluetooth hardware during the manufacturing process and cannot be changed. 
· Accessibility: 
  Allow other devices to connect—when this option is enabled, other devices are permitted to connect to 
this device. Two mutually exclusive sub-options provide additional refinement. They are: 
  All devices—select this option to allow all devices to connect. 
  Paired devices only—select this option to allow only devices that have a paired relationship (see 
Section 3.2.2) with this device to connect. 
  Other devices can discover me—when this option is enabled, other Bluetooth devices can see and 
report this device. Even though remote devices cannot discover this device unless this option is checked, 
if a remote device has this device’s Bluetooth Device Address, that device may still be able to connect to 
this device (see Note below). 
NOTE: The ability of remote devices to connect is also subject to security restrictions and whether 
Bluetooth is enabled on this device. 
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2.3 BTW-CE SERVICE TABS 
The functions that a PocketPC can provide to other devices are called “Services.” 
The services that this PocketPC is capable of providing are: 
· File Transfer—file-related operations such as get a file/use a file/delete a file, etc. 
· Information Exchange—Send the default business card (Pocket Outlook contact) on request. 
· Serial Port—Bluetooth serial port operations. Bluetooth serial ports are used as a replacement for a 
physical cable between devices. 
· Dial-up Networking—provide access, via a phone line or other access system, to a remote computer 
network such as an Internet service. 
Each of these tabs is explained in detail in the remainder of this section. 

 
2.3.1 Common Options 

All of the services have some common settings. Even though the options are the same, in each case they 
are specific to the service being configured on the individual tabs. 
The common options are listed under the About this service heading on each individual service tab. 
They are: 
· Enable service: check this option to have the service start when BTW-CE initializes. When this option 
is enabled the service is enabled and “listening” for connection attempts when Bluetooth is enabled. 
· Authorization required: check this option to require that each attempt to establish a connection be 
individually authorized. When Authorization is enabled and a remote device attempts to connect to this 
service, BTW-CE asks if the connection should be permitted. 
· Authentication (Passkey) required: check this option to require a passkey or a Link Key from the 
remote device before allowing the connection. When this option is enabled and a remote device attempts 
to establish a connection, the Bluetooth Passkey screen appears. Enter the passkey to allow the 
connection to proceed, or tap the OK button to deny permission for the connection. If the notification is 
ignored, the connection attempt will time out (fail). 
· Encryption required: check this option to require that all the data exchanged between this device and 
the remote Bluetooth device be encrypted. Encryption depends on the key that is used for Authentication; 
if Authentication is not enabled, Encryption will not be available. Only the data exchanged by the 
Bluetooth devices is encrypted. 
The individual services, and their unique options, are explained in the remainder of this section. 

 

2.3.2 File Transfer Tab 
The options on this tab only affect incoming File Transfer connections. 
All of the Common Options (see Section 2.3.1) are available. 
There is one additional configurable item: “My shared folder,” which allows you to specify the default 
File Transfer directory, the highest level directory on this PocketPC that remote devices have access to. 
To change the default File Transfer directory, tap , navigate to the desired directory, and then tap the OK 
button. 

 
2.3.3 Information Exchange Tab 

The Common Options (see Section 2.3.1) on this tab only affect incoming Information Exchange 
connections. 
There is one additional configurable item: “My business card (vCard)”. 
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The “My business card” information comes from a selected record in the Contacts list of Pocket Outlook. 
Information from the selected record is sent to remote devices on request. It is also the contact 
information that is sent when you select “Send your business card to one or more recipients” while using 
Business Card Exchange. 
The default selection is “none” (no information). 
To select a vCard, tap, choose a contact from the list, and then tap OK. 
To discontinue sending contact information when it is requested, tap, choose “(none)” from the list, and 
then tap OK. 
If you reach the contacts list by mistake, tap OK to return to the previous screen. 

 
2.3.4 Serial Port Tab 

The configurable options on this tab only affect incoming Serial Port connections. 
All of the Common Options (see Section 2.3.1) are available. 
There are two additional, non-configurable items: 
· Inbound COM Port: the local communications port that is used for inbound serial connections. 
· Outbound COM Port: the local communications port that is used for outbound serial connections. 
The Inbound and Outbound COM ports are permanently assigned and cannot be changed. 

 
2.3.5 Dial-up Networking Tab 

The options on this tab only affect incoming Dial-up Networking connections. 
All of the Common Options (see Section 2.3.1) are available. 
There are three additional items: 
· COM Port: select the communications port to be used. 
· Baud rate: tap the down-arrow and select a baud rate from the drop-down list. The options range from 
1,200 to 115,200 baud, in nine steps. 
· Flow control: tap the down-arrow and select the type of flow control to be used from the drop-down list. 
The options are: 
  Off 
  Hardware (RTS/CTS). 

 
2.4 ABOUT TAB 

This tab provides: 
· Release Version information 
· Copyright notice 
· An Advanced button, which displays a screen that contains version information about the individual 
software modules that make up BTW-CE. 
There are no configurable options on this tab. 
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3 Bluetooth Manager: Using BTW-CE 
The Bluetooth Manager allows you to setup connections and communicate with remote devices over 
Bluetooth. The Bluetooth Manager is accessed as follows: 
1. From the Today screen, tap > Programs > Bluetooth Manager. 
– or – 
2. From the Today screen, tap > Bluetooth Manager. This option is available if you checked off Add a 
shortcut in the Start menu when you installed BTW-CE. 
The Bluetooth Manager has: 
· Two tabs: 
  My Shortcuts—displays pre-configured connection icons and establishes connections 
  Active Connections—displays active incoming and outgoing connections. 
· Three menus: 
  New 
  Connect!—create a new connection using the Bluetooth Connection Wizard 
  Tools 
  Paired devices—pair/un-pair with other devices 
  Business Card Exchange—opens the Business Card Exchange. 
  View—controls the on-screen display (icons or list). 
· Two icons: 

Accesses the Bluetooth Connection Wizard, which helps you setup connections with remote Bluetooth 
devices. This icon is a shortcut to the New > Connect! menu item. 
Accesses the Bluetooth Business Card Exchange screen. This icon is a shortcut to the Tools > Business 
Card Exchange menu item. It allows you to: 
  Get a business card from a remote device 
  Send your business card to a remote device 
  Exchange business cards with a remote device. 

These options are explained in detail in the remainder of this section. 
 
3.1 TABS 

The two tabs at the bottom of the Bluetooth Manager screen are: 
· My Shortcuts 
· Active Connections. 

 
3.1.1 My Shortcuts 

The default tab on the Bluetooth Manager is My Shortcuts. This screen displays the icons that have been 
created for connections to other devices. The icons provide visual feedback about the status of the 
connection to which they are linked. 
The double-tap is context sensitive: 
· If the connection is not open—double-tap its icon to establish a connection 
· If the connection is open—double-tap its icon to display the connection’s status screen. 
Connections can also be opened/closed, and other options accessed, using the tap-and-hold technique. If 
you tap a connection icon and hold the stylus in place for a few seconds, a context sensitive menu 
appears. 
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3.1.2 Active Connections 
This tab displays the currently active Outgoing and Incoming Connections on the PocketPC. 
To the right of each active connection icon is a signal strength indicator. 
Tap-and-hold a connection to access a context sensitive menu. The menu options are: 
· Disconnect—close this connection 
· Status—display the connection status screen (Section 3.1.1.2). 

 
3.2 MENUS 

There are three menus on the bottom of the Bluetooth Manager. They are: 
· New 
· Tools 
· View. 

 
3.2.1 New 

The New menu has only one option; Connect! 
Connect! starts the Bluetooth Connection Wizard, which walks you through the process of creating a 
connection. The first screen lists several types of connections you can create. Choose the type of 
connection and then Next. The next page(s) will guide you through establishing the parameters of the 
desired connection. The exact content of the page(s) depends on the type of connection being created. On 
any given page, where applicable, choose Next to move to the next page, or Back to return to the 
previous page. 

 

3.2.2 Tools 
The Tools menu has two options: 
· Paired devices 
· Business Card Exchange 
3.2.2.1 Paired Devices 

When two devices are paired, they share, and exchange prior to each connection, an internally 
generated security key. This security key, called a Link Key, is based on a unique Bluetooth Device 
Address, a random number, and a user-defined password. 
To pair with another device: 
1. From the Bluetooth Manager, Tools menu, select “Paired devices…” 
2. On the Paired devices screen, tap Add 
3. On the Device Pairing screen: 

a) Tap 
b) Tap a device on the “Select a Bluetooth device” screen to return to the prior screen and populate 
the “Device:” field. 
c) Enter the correct password in the “Passkey:” field 

4. Tap OK. 
To break (remove) a Paired Relationship 
1. From the Bluetooth Manager, Tools menu, select “Paired devices…” 
2. Tap a device name to select it 
3. Tap the Remove button, and then tap Yes in the confirmation dialog. 
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3.2.2.2 Business Card Exchange 
Business Card Exchange is accessible from: 
· An icon on the Bluetooth Manager’s menu bar 
· From Tools > Business Card Exchange. 
Business Card Exchange allows you to: 
 Send your business card to one or more remote devices. 
 Request a business card from one or more remote devices 
 Exchange business cards with one or more remote devices. 
NOTE: To Send or Exchange business card(s) you must first specify your default business card in the 
Bluetooth Control Panel, Information Exchange tab (see Section 2.3.3). 
To Send, Request or Exchange Business Cards 
1. From the Bluetooth Manager, tap the business card icon 
2. Tap the Send, Request or Exchange icon, as appropriate. 
From the Bluetooth Browser screen, tap the name of the remote device and then tap OK. 

 
3.2.3 View  

The View menu has two options. They are: 
· Icons—select this option to view the on-screen connection icons as large icons 
· List—select this option to view the on-screen connection icons in list format. 

 
3.3 ICONS 

There are two icon shortcuts on the bottom the Bluetooth Manager screen. They are: 
New Connection—a shortcut to the New > Connection shortcut… menu item. See Section 3.2.1 for 
information on how to create a new connection. 
Business Card Exchange—a shortcut to the Business Card Exchange menu item. See Section 3.2.2.2 
for information on how to use Business Card Exchange. 
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4 Bluetooth Browser 
Various BTW-CE applications require you to select the device you want to connect to. For instance, from 
the Bluetooth Manager, when creating a connection to explore a Bluetooth device, you must select the 
device to connect to. 
Whenever you are required to select a device, the Bluetooth Browser window automatically shows up 
and starts searching for other Bluetooth devices. As the search progresses, devices will gradually be 
listed in the window. To select a particular device, simply tap on it (whether the search is ongoing or 
stopped). This will close the window and return to the previous screen. 
The search automatically terminates after a few seconds. You can interrupt it by tapping the Stop icon at 
the bottom of the screen. Once stopped, you may restart the search (i.e. refresh the list) by tapping the 
Refresh icon. Note that in some instances, it may be necessary to refresh the list once or twice to “find” 
all Bluetooth devices around. 
Located at the bottom of this wizard screen are: 
· An optional*1 drop-down menu with two options: 

Preferred*2—when this option is selected the wizard attempts to display only those devices that 
potentially offer the desired service. 
All devices—select this option to have the wizard display all devices in the vicinity, without regard to 
the type of service(s) they offer. 

· The View menu, which has two options: 
Icons—displays the found devices as large icons 
List—displays the found devices in a list. 

· An icon—the icon that is displayed is determined by what the wizard is doing: 
The wizard is searching for devices. When the desired device appears on the screen, tap the device to 
select it and stop the search. You can also stop an in-process search by tapping. 
The wizard has completed its search for devices. Tap to search again or to refresh the screen. 

· Cancel button—tap this button to close the window and return to the previous screen without changing 
the selected device. 

 
*1: In some cases, the drop-down menu is not shown when only one type of devices is shown. 
*2: Another term may be used when applicable (.e.g “Phones”). 

 



MBH2BT01 User’s Guide  Using Remote Device Services 

    
 Copyright © FUJITSU MEDIA DEVICES LIMITED 2003 14 

5 Using Remote Device Services  
This section provides overview instructions for using services provided by other devices. 

 
5.1 SERIAL PORT 

The use of a Bluetooth wireless serial port connection is identical to the use of a physical cable serial port 
connection between two devices. 
As with a physical connection, the application that will use the connection must be configured to use the 
correct serial port. 
To determine the communications port assigned to the Bluetooth serial port: 
1. From the Today Screen, tap the Bluetooth icon to open the Bluetooth Control Panel. 
2. Use the scroll arrows at the bottom-right of the screen to expose the Serial Port tab, and then select the 
Serial Port tab. The Outbound COM Port is listed in the lower portion of the screen. Configure the 
application that will use the Bluetooth Serial Port to send data to this port. 
NOTE: For information about configuring your application’s outbound COM port, refer to the 
application’s documentation. 
3. From Bluetooth Manager’s My Shortcuts screen open the Bluetooth serial port connection to the 
remote device. 
4. Send/Receive data from the application. 

 
5.2 DIAL-UP NETWORKING: CONNECT TO A REMOTE COMPUTER 

Dial-up Networking allows you to connect to a remote computer via a phone line. Once connected, you 
can browse the Internet, check your email, etc. 
The remote Bluetooth device that will provide the Dial-up Networking service must have access to a 
telephone system (either a physical or cellular connection). 
Devices that might provide the Dial-up Networking service include: 
· Bluetooth-enabled cellular telephones 
· Bluetooth-enabled desktop computers that are attached to a telephone system 
· Bluetooth modems. 
The remote computer to which you are connecting must also be attached to the phone system and capable 
of answering a call. 

Figure: Dial-up Networking overview 
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To use Dial-up Networking: 
1. Create a connection to the device that will provide telephone access (see Section 3.2.1). 
2. From the Bluetooth Manager, My Shortcuts tab, tap-and-hold the Dial-up Networking connection 
shortcut, and then select Connect from the pop-up menu. 
3. On the first Bluetooth: New Dial-up Connection screen, double-tap New Connection… 
4. On the second Bluetooth: New Dial-up Connection screen: 

a) Enter a name for the connection 
b) If dialing outside of the default country setting, enter the country code 
c) If dialing outside of the default area code setting, enter the area code 
d) Enter the phone number to be dialed. 

5. Tap OK 
To proceed with the connection, you must complete the PocketPC screen(s) that follow(s). Refer to the 
PocketPC documentation for assistance. 
After the connection is active, open a web browser on the PocketPC. 
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5.3 BLUETOOTH FILE EXPLORER 
Bluetooth File Explorer appears automatically when a File Transfer connection is established. It allows 
you to: 
· Navigate the directory structure of the remote device 
· View files and folders on the remote device 
· Create new folders on the remote device 
· Send files to, and get files from the remote device 
· Delete and rename files on the remote device. 
NOTE: File operations on the remote device are limited to the remote device’s configured FTP root 
directory and its sub-directories. 
Bluetooth File Explorer also allows you to set the folder on your PocketPC that will receive inbound files. 
This folder is configurable on an individual basis for each connection shortcut. 
Bluetooth File Explorer has two menus: 
· File: 

Send a File… 
Create a Folder 
Get 
Rename 
Delete. 

· Tools: 
Set Local Folder 
Refresh. 

 
5.3.1 Change the Remote Device Folder 

To move down in the directory structure of the remote device, tap the new folder in the main portion of 
the Bluetooth File Explorer window. 
To move up in the directory structure of the remote device, tap the down-arrow to the right of the 
currently selected folder and select the new folder from the drop-down list. 

 
5.3.2 File Menu 

All of the instructions in the subsections that follow assume that there is an open File Transfer connection 
with a remote device.  
5.3.2.1 Send a File to the Remote Device 

To send a file to the remote device, from the File menu, tap Send a File… to display the Open screen. 
The options on the Open screen are: 
· Folder—tap the down-arrow and select the folder that contains the file to be sent. 
· Type—the only option is “All Files (*. *)” 
· A list of files in the selected folder; tap the file to be sent 
· Cancel button—aborts the Send a File… operation. 
The selected file is sent automatically when it is tapped, without further intervention, and the 
Bluetooth File Explorer main screen reappears. 
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5.3.2.2 Create a Folder on the Remote Device 
To create a folder on the remote device, navigate to the folder in which the new folder will be placed, 
and then, from the File menu, tap Create a Folder. Enter a name for the new folder while the default 
name (New Folder) is highlighted. 

5.3.2.3 Get a File From the Remote Device  
To get a file from the remote device: 
1. Navigate to the folder on the remote device that contains the file 
2. Tap the desired file to highlight it 
3. From the File menu, tap Get. 
The file is copied to the local folder listed in the Local Folder field near the top of the screen. 
This operation can also be performed using the tap-and-hold technique: tap-and-hold the desired file 
and select Get from the pop-up menu. 

5.3.2.4 Delete a File on the Remote Device 
To delete a file on the remote device: tap the file to be deleted to highlight it, then, from the File menu, 
tap delete. Tap OK in the confirmation dialog box. 
This operation can also be performed using the tap-and-hold technique: tap-and-hold the desired file 
and select Delete from the pop-up menu. Tap OK in the confirmation dialog box. 

 
5.3.3 Tools Menu 

5.3.3.1 Set Local Folder 
The local folder, i.e. the folder on the PocketPC where incoming files are placed, can be configured on 
an individual basis for each connection shortcut. 
To configure the local folder: 
1. From the Tools menu, tap Set Local Folder 
2. Use the drop-down menu at the top of the screen to navigate to the desired folder 
3. Tap OK to return to the Bluetooth File Explorer main screen. 
The Local Folder field is updated to reflect the new folder selection. 
NOTE: The Local Folder information is associated with the shortcut to the connection that is open 
and is saved with the active profile. A different Local Folder can be associated with each File Transfer 
shortcut. 

5.3.3.2 Refresh 
To refresh the list of displayed files and folders on the remote device, from the Tools menu, tap 
Refresh. 

 
5.4 SEND VIA BLUETOOTH 

Pocket Outlook contacts, calendar items, and tasks can be sent individually or collectively to a remote 
device. 
To send data via Bluetooth transfer: 
1. From the Start menu, Programs, open Calendar, Contacts or Tasks 
2. Highlight the item(s) to be sent 
3. Tap-and-hold the item(s), and from the pop-up menu, tap Send via Bluetooth. 
4. On the Select a Bluetooth device screen, tap the name of the destination device, and then tap OK. 
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APPENDIX A – SPECIFICATIONS 
 

Bluetooth Specification Version 1.1 Compliant 
 

CompactFlash Specification Revision 1.4 compliant 
(ComapctFlash Card TYPE I Extended) 

 
Carrier Frequency 2400MHz - 2483.5MHz 

 
Modulation  0.5 BT Gaussian-filtered 2FSK at 1Msymbol/s 
    Modulation index: 0.25 to 0.35 

 
Symbol Rate  1Mbps 

 
Channel   79ch 

 
Channel Space  1MHz 

 
Transmit Power  Power Class 2, +4 dBm (maximum) 

 
Outer Dimensions 54.5 x 42.8 x 7.2 mm 

 
Weight   25 g 

 


